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1 Introduction 

1.1 Overview  

UC Office provides end-users with a Unified Communications (UC) experience across 
mainstream mobile and desktop platforms including Windows, Mac, iOS and Android.  

Seamlessly integrating a full suite of UC services; UC Office is a single application offering 
access to voice, video, instant messaging & presence, audio conferencing and web 
collaboration services.  

Replacing or complementing your hard phone, UC Office for Desktop provides a complete 
Unified Communications application for Windows and Mac. This document details how to 
install, login and begin using UC Office for Desktop. 

 

2 Requirements  

 
In order to successfully install and use UC Office, the following installation and licensing 
requirements should be met: 

2.1 Hardware and Software Requirements 

Processor  
Minimum 1 GHz; however, 1.5 GHz is recommended, Pentium 4 at a minimum, dual core CPU 
is recommended for video calls at a minimum 

Memory 
Minimum: 1 GB RAM 

Minimum: 2 GB RAM for Video 

Hard Disk Space Approx. 125 MB 

Operating System 

Mac OS 10.6 Snow Leopard 

Mac OS 10.7 Lion 

Mac OS 10.8 Mountain Lion 

Windows XP, Vista  

Windows 7, or Windows 8 (Classical view only) 

Additional Open Graphics Library (OpenGL) 1.5 or higher is recommended 

Connection 
Minimum: IP network connection (broadband, LAN, wireless) 

Recommended: A 2.0 Mbps connection 

Sound Card Full-duplex, 16-bit or use USB headset 
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Local admin rights are required to carry out the installation so you must use a Windows user 
account with administrator-level access. 

Some anti-virus software can cause problems when installing other software so consider 
temporarily disabling your anti-virus application for the duration of this installation; 
remember to enable it again as soon as the installation is complete. 

2.2 Multimedia Device Requirements 

UC Office requires both speakers and a microphone to make calls. Any of the following are 
acceptable: 
 
 External speakers and microphone 
 Built-in speakers and microphone 
 Dual-jack multimedia headset 
 Bluetooth® multimedia headset 
 USB multimedia headset 
 USB phone.  
 

Video Cameras 
Calls made with UC Office will work without a video camera, but a video camera is necessary 
to allow other parties to see your image. UC Office will work with most built in and USB video 
cameras. 

2.3 Licensing Requirements 

End users must have the UC Business or UC Team Add-On assigned to their account or a 
Unified Coms User or Unified Mobility User licence in order to use the application. 

2.4 Network and Firewall Requirements 

You may need to allow outbound access for the following on your firewall: 
 
 

Protocol Destination Destination Port 

HTTPS 

 
ucoffice.yourservices.co.uk 
85.119.59.31 
 
webcollab.ucoffice.eu 
95.172.95.114 
 
ucoffice.eu 
95.172.95.82 
  

TCP 443 

XMPP 
ucoffice.eu 
95.172.95.82 

TCP 5222 and 1081 
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SIP 

 
uk.ic.hnt.Cloud Direct.co.uk 
uk.ic.56hnt.Cloud Direct.co.uk 
85.119.63.1 
 

UDP/TCP 5060 to 5070 

RTP 

 
uk.ic.hnt.Cloud Direct.co.uk 
uk.ic.56hnt.Cloud Direct.co.uk 
85.119.63.1 
 

UDP 16384 to 32766 

DNS 
 
Supplied locally 
 

UDP/TCP 53 

  
The local requirements can vary from installation to installation; ask your system 
administrator for details or assistance if required. 
 

3 Installation 

3.1 Windows 

Log in to an administrator-level user account on the Windows workstation that UC Office 
needs to be installed onto. 
 
To begin installing UC Office, run the ‘ucoffice.exe’ file and click Next. 
 

 
 
Accept the License Agreement if you wish and click Next to proceed. 
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Follow the installation prompts. 
 

 
 
Click the Install button to commence the installation. 
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Once UC Office and any third-party software have finished installing, click the ‘Finish’ button to 
close the installer. 
 

 

3.2 Mac 

Log in to an administrator-level user account on the Mac workstation that UC Office needs to 
be installed onto. 
 
To begin installing UC Office, double-click the ‘ucoffice.dmg’ file. Drag the UC Office Application 
Icon to the Applications Folder to install. 
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4 Login, Password Management and Initial Configuration 

4.1 Startup and Login 

To start UC Office, start it as you would any other program. For example, double click on the 
UC Office application short cut. 
 

 
 
Once the application has launched, UC Office presents you with the login screen where you 
need to provide your user account information. 
 
Enter your username and password into the appropriate boxes and click Sign In to start using 
UC Office. 
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4.2 Username and Password Management 

You must login to UC Office with your Application Username and Password. This may be 
included in your VoIP User Detail Setup Email. 
 
Passwords are used for UC Office login; please follow standards for Password Protection 
Policies. 
 
Your Username takes the format of your email address. 
 
For example; user.one@customer.co.uk 
  
Passwords can be modified or reset by contacting the Cloud Direct Support team. 

4.3 My Room Integration Configuration 

If you have been assigned the UC Team Add-On or have a Unified Mobility User licence you 
can enter your My Room Audio Conferencing and Web Collaboration details into UC Office for 
Desktop. This enables Desktop Sharing, My Room Audio Conferencing and Web Collaboration 
portal integration within UC Office for Desktop. 
 
Your My Room Audio Conferencing and Web Collaboration credentials may be included in 
your VoIP User Detail Setup Email or can requested or changed by contacting the Cloud Direct 
Support team. 
 
When signed in to UC Office Desktop click the Menu icon and select Preferences and enter 
your My Room details in the Credentials tab: 
 

 
 
 

5 Getting Started, Making Calls and Call Control 

5.1 Main Window 

When you start UC Office for the first time, the contact list is empty. Use the search field to 
find people and add them to your contact list. Contacts can also be added manually by clicking 
the Add button. 
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My Information – View and update your information, including presence, avatar 
and location. 

 
My Room – Your permanent communication room. Participants can dial into 
your audio conference bridge. 

 
Contacts – View your contacts. 
 
Communication History – View previous chats and calls 

 
Chat – Start an instant message conversation with a selected contact. 

 
Call – Make an audio call to a selected contact (VoIP) 

 
Call from Phone – Make a click-to-dial call from your desk phone (or secondary 
device) 

 
Video Call – Make a video call to a selected client (VoIP) 

 
Share Desktop – Share your desktop with a selected contact, only the owner can 
share 

 
Add – Add a contact, group or conference 
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My Information  
 

 Click the avatar to update your status, free text, and location.  

 Double-click the avatar to upload a picture.  

 Right-click on the avatar to update your status, preferences etc. 
 
Presence 
 
You can set your presence to one of the following statuses: 
 

 
 
UC Office can automatically update your presence to the following:  

 Busy – In call  

 Busy – In meeting (Windows only)  
 
Location  
 
Your location is automatically determined by your public IP Address, but you can manually set 
the text to display for your location and the time zone using the location dialog box. 

5.2 Communication Window 

After starting communication with one or more contacts, a Communication window is 
displayed. From this window you can perform the following actions: 
 

 Escalate a chat to include audio, video, and desktop sharing. 
 End an audio or video call. 
 Open the dial pad. 
 Mute your microphone. 
 Adjust your speaker volume. 
 Place the call on hold. 
 Transfer the call. 

5.3 Start a Chat 

Start a chat using one of the following methods: 
 

 Double-click a contact in the Contact list or from Search results. 
 Left-click one or more contacts from the Contacts list or Search results and click the 

Chat button. 
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 Right-click one or more contacts from the Contacts list or Search results and click the 
Chat button. 

 In the Communication History list, double-click a chat entry. 
 In a Communication window, click the Chat button. 

 
In a one-to-one chat, transfer files by clicking the Send File button in the Communication 
window or use drag-and-drop onto the Communications window. 

5.4 Make an Audio or Video Call  

Make an audio or video call using one of the following methods: 
 

 Left-click one or more contacts from the Contacts list or Search results and click the Call, 
Call from Phone, or Video button. 

 Right-click one or more contacts from the Contacts list or Search results and click the 
Call, Call from Phone, or Video. 

 Enter a phone number in the Search and Dial field. 
− Press Enter to start a VoIP call. 
− Click the Call, Call from Phone, or Video button. 

 Open the dial pad, enter a phone number, and click the Call, Call from Phone, or Video 
button. 

 In the Communication History list, double-click a call entry. 
 In the Communication window, click the Call, Call from Phone, or Video button. 
 When viewing a contact’s profile, click the Call, Call from Phone, or Video button. 

 
NOTE: If dialing a phone number that requires additional Dual-Tone Multi-Frequency (DTMF) 
tones (for example, a conference bridge), you can type the numbers on your keyboard while the 
Communication window has focus or open the dial pad in the Communication window. 

5.5 Share Your Desktop 

Share your desktop by following these steps: 
 

 Click the Share Desktop button. 
 Click the Start button after the share preparation has completed. 

 
NOTE: To share your desktop, you must enter your Web Collaboration credentials in 
Preferences → Credentials. For additional information, see Preferences. You can participate in 
desktop sharing sessions by another user even without having your own sharing credentials. 

5.6 Active Communications 

Active communications display at the top of the Contacts list in the main window. This area 
provides an easy view to see with whom you are communicating. The following is also 
available in this area: 
 

 Double-click an active communication to bring that Communication window to focus. 
 See who has sent you an unread chat. 
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 End a call. 
 Mute your microphone. 
 Place a call on hold. 

5.7 My Room 

My Room is an always available and permanent room, with which you can chat with anyone 
that joins. 
 
If you have My Room Audio Conferencing and add the details to your profile in Preferences → 
Credentials, then in your room, you and your attendees can click the Call or Video button to 
have UC Office automatically dial in to the conference and enter the appropriate entry codes. 
 
You can invite others to your room by dragging and dropping them from the Contacts list into 
the My Room Communication window. 
 
Others join your room by right-clicking on your name in their Contacts list and selecting Join 
Room. 

5.8 Selecting Audio Devices 

If you have multiple audio devices available for your microphone or speakers, select the 
preferred audio device before starting a call. 
 
1) Click the UC Office logo in the main window title bar. 
2) Select Preferences. 
3) Select Audio. 
4) Set a Playback Device (Speakers). 
5) Set a Recording Device (Microphone). 
6) Click OK. 
 

6 Contacts 

 
Contacts are the people that you communicate with and in most cases see their presence and 
share your presence with them. There are three types of contacts. 
 

 Contacts – Actual people with whom you communicate 
 Conferences – Audio or Video conference bridges that you use to communicate with 

others 
 Groups – Containers of Contacts and/or Conferences 

6.1 Add 

When you sign in for the first time, there are no contacts on your contact list. Add a new 
contact at any time by selecting the Add Contact item from the menu or choose the Add 
Contact button from the main window. 
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In the Add Contact dialog box, enter the contact’s information and then click Add Contact. By 
default, your presence information is always shared with a new contact if a proper 
<username>@ucoffice.eu IM&P Address is entered for the contact. 
 
However, you can always share your presence information later by selecting Subscribe on the 
menu for that contact on the contact list (right-click on the contact or arrow button). Note that 
the contact must accept your subscription request for you to establish the presence 
relationship successfully. 
 
The newly added contact appears on your contact list. 
 
Add a conference contact by clicking the same button as for “Add contact”, and choosing the 
Add conference menu option. A conference contact is a special contact used for conference 
bridges to avoid remembering PIN codes and conference number for example, recurring 
conferences. Just create a contact for the weekly conference, add conference bridge number 
and PIN and join the conference by just right clicking the contact or choosing it and clicking 
the call button. 
 
Choose the Add group menu option to add a new group to the contact list. 

6.2 Edit 

Edit a contact by selecting the contact first. After you select the contact, right-click anywhere in 
the area of the selected contact and a menu of options appears. This base principle is the 
same for normal contacts, conference contacts, and groups. 
 

 Unsubscribe removes the presence relationship between you and that contact. This 
means you do not see the contact’s presence information and your contact does not 
see yours. Select subscribe to re-establish the presence relationship. An unsubscribed 
contact remains in the contact list and is always shown as “offline”. 

 Remove removes the contact from your contact list. 
 View Profile opens the Contact Information dialog box where you can add, edit, or 

remove information. This works for both normal and conference contacts. 
 For groups, choose the Edit menu option to rename a group. 

 

6.3 Filters  

You can filter contacts in two ways:  
 

 Use the filter field to search by contact name. The contact list is filtered in real time as 
you type.  

 Alternatively, use the filter icons in the left side navigation to display only specific types 
of contacts such as favourites, conference contacts, or online contacts. 
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7 Presence 

 
For each contact you have subscribed to, you can see their presence. Respectively, your 
contacts see your presence in their contact list. 
 
Presence means that your friends are able to see whether you are available to communicate, 
for example, “I’m busy” or “I’m available”. 
 

 
 
 
If you see an error message at the top of the Main window “XMPP Unavailable”, it means that 
the XMPP connectivity has been lost for chat, as well as for presence; however, you can still 
make calls. You should contact your service provider if this persists. 
 
Have Outlook calendar automatically change your presence to “Busy – In Meeting” by enabling 
this in the Preferences → General tab. 
 
The presence update is only triggered by appointments and meetings that are either accepted 
by the user or made by them. All day meetings do not trigger a presence change to "Busy - In 
Meeting". 
 
The IM&P address of a contact cannot be changed. Instead, you must delete the old one and 
create a new one. 
 
Location in presence is done based on the IP address that the machine is using. The IP 
address is mapped to a physical location.  Change the location manually by clicking the avatar 
and then the location icon to go to the manual location and change view. 
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8 Chat 

8.1 Chat View 

When you initiate a chat, the Chat window opens. Chatting with a contact is possible only when 
you are both online. If your contact initiates a chat, you see a pop-up notification in the bottom 
right-hand corner of the screen. If you close the Chat window and open it again, sent chat 
messages are shown in the window as chat history. 
 
At the top of the message area, there are four links: Yesterday, Last week, Last month, and All 
history. From these links, you can load history from your local storage from different time 
frames. You can delete the history using the Options menu. 
 
In the text field, you can add a smiley. Smileys can also be added by manually entering the 
corresponding characters that represent that particular smiley. You can send text by pressing 
Enter. 
 
To enter a line break in the text field, you can use the following key commands. 
 

 Control + Enter 
 Shift + Enter 
 Alt + Enter 

 
Use either of the short commands, Ctrl+C and Ctrl+V, or right-click the selection for a menu to 
copy or paste the text to or from the Chat window. 

8.2 File Transfer 

File transfer functionality is accessible only through chat window. Click Send File-button on top 
of the text field to open the file selection dialog. Select the file to be sent from the dialog and 
press Open. You can also drag and drop a file into the chat window. 
Once the file offer is issued and also during the transfer, you can cancel the transfer at any timer 
by pressing Cancel. 
 
Accept an incoming file transfer by pressing the Accept button. Selecting the Decline button 
rejects the file transfer offer. 
 
After the file transfer has completed, the received files can be opened or observed in file 
manager by using the Click to open and Show in folder links. 

8.3 Group Chat 

Start a group chat by multi-selecting and right-clicking in the main window contact list or 
through My Room in the communications window. More people can be added later to the chat 
by dragging-and-dropping contacts into the window. Only the owner can add more participants. 
 
A group chat works the same way as a one-to-one chat. All messages from anyone are sent to 
everyone else. All contacts need to be online to be able to participate in a group chat. You cannot 
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invite an offline contact or a contact that is not on a device that supports group chat. This does 
not affect the group chat in any way. 
 
A group chat history is saved and is available to view later in the Messages tab of the main 
window. 
 
In the text field, the contacts’ names appear in different colours to easily distinguish between 
who is writing. 
 
Only the newest chat room messages are stored on the server. One-to-one chat 
messages are only saved locally. 
 

9 Audio and Video Calls 

 
The following table describes some additional communications window icons and what you 
can do with them, for voice and video calls. 
 

 
 
 
In the Options menu there are the following options: 
 

 Transfer a call to a third party. 
 Put the call on hold. Note that if you hold the call, the other party cannot “un-hold”. 

This freezes a video call to the last frame of the video feed. In both voice and video 
calls, this is communicated to all parties by a notification appearing in the middle of 
the screen. 

 Hide your own video. 
 Add participants to the call. 
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Dial a number in the combined search and quick dial field to make a call. Once you type your 
numbers, UC Office searches for contacts in both the local contact list and in the Company 
directory. 
 
Choose your video resolution from Preferences and the Video tab. Your selection is used by 
default for future video calls. The available resolutions are automatically presented based on 
your camera. 

9.1 Make Call from Your Computer  

Select a contact from your contact list to start communication and click the desired 
communication button. Type a phone number in the search and dial field at the top of UC 
Office window (search or communicate), to communicate with someone who is not on your 
contact list. 

9.2 Call from Phone  

The second option to communicate in the row of communication buttons is the Call from 
Phone. When you press this button, the desk phone instantly starts ringing and the call is 
established from your desk phone. This depends on your service provider configuration as 
other devices might also ring. 

9.3 Answer Call 

When someone is calling you, you see a pop-up notification on your screen. You can choose to 
answer, silence, or reject the call. If you silence the call, the ringtone is silenced but the caller 
does not see anything on their end. You can answer or reject the call after silencing it. Kill the 
incoming call popup to silence an incoming call. 
 
If you reject the call, it causes the line to sound busy at the caller’s end and they know that you 
rejected the call. 
 
When someone is calling you with video, you see the same pop-up notification, but the options 
are answer, answer as voice only, silence, or reject. If you decide to answer as voice only, the 
call is voice only. 

9.4 Contact Name Lookup for Incoming Calls 

Whenever the incoming call does not have a calling name associated with it, UC Office can 
perform a local contact search. If the number matches one of the contacts on UC Office 
contact list, the name is shown on the incoming call screen along with the alert. 
 
Whenever you retrieve your call logs/history and the call log does not have a calling name 
associated with it, UC Office does a lookup in the local contacts and populates the name if a 
match is found. 
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9.5 Missed Call or Communication 

When you have one or more missed calls or other types of communications, there is a 
notification on the left side navigation of the main window. Clicking the icon takes you to the 
missed communication in the Communications History view. 

9.6 Full Screen in Video Call 

Full screen mode can be activated by clicking the full screen button or by double-clicking 
anywhere on a video. 
 
Exiting full screen mode is done by pressing the ESC key or the window button. Exiting full 
screen makes the video call go back to its original state (even if there was resizing of the 
window previously before going full screen). 
 
In a full-size window, you can see a similar Options menu at the top. It has the same 
functionality as in the normal view. When you move the mouse, the top bar and lower 
communication buttons appear on top of the video. 

9.7 Multi-Party Sessions 

You can have up to 8 participants in a call in My Room. Add participants by dragging and 
dropping them onto the communications window, or selecting the Conference menu item via 
the Communications window menu button. By choosing the menu item you can also add 
participants with just a telephone number. 

9.8 Call Waiting 

You can have one active call at any one time, if you get a new incoming call and accept it, the 
existing call is put on hold and you can change between these two calls by using the 
Hold/unhold buttons. 

9.9 Call Transfer 

Blind call transfer is available in the Communications window by choosing the Transfer Call 
menu item. 

9.10 Message Waiting Indication 

The Message Waiting Indication (MWI) service allows you to receive a notification for a waiting 
voice mail or video mail. By clicking on the message icon in the upper right-hand corner of the 
main window, UC Office calls the predefined mailbox number to allow the user to listen to the 
voice mail or view the video mail. 
 
Missed calls are indicated by an icon in the main window. Missed video and audio calls are 
indicated with a different icon. Note that the MWI icon is in the same place for indicating new 
voice mail. 
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10 Share Desktop 

 
Select a contact and click the Share Desktop button to share your desktop in the main window. 
In the Communications window, click the Share Desktop button. This does not yet start the 
share but sets up connections to the server. Once the server connection is set up, a Play 
button appears to actually start sharing your desktop. 
 
To stop sharing, click the Stop icon. You are prompted to confirm the stopping of the share. 
While sharing all other communications mechanisms are also available, except for video 
calling and file transfer. Click on the chat button in the Communications window to hide or 
unhide the chat view. 
 
Desktop share works the same way in both My Room and ad hoc sessions. For participants 
without UC Office, use the separate desktop share invitation link available in the My Room 
icon right click menu. 
 

11 My Room 

 
My Room is started by clicking on the My Room icon on the left side navigation. My Room is 
started automatically using your permanent chat room. Add more participants by dragging 
and dropping them into the Communications window or conference menu, or they can join 
your room by right-clicking you in their contact list and choosing the Join room menu option. 
Once people have joined the chat room, they can click on the Call button of that window to 
also join the conference. The room owner can also share their desktop. 
 
To use the full functionality of My Room (desktop share, conferencing, and chat combined), 
you need to manually enter desktop sharing credentials, and your conferencing number and 
PIN in the Preferences → Credentials window. 
 
Only the owner of the room can share the desktop or add more participants. This applies to 
both My Room and ad hoc sessions. 
 
Right-click on the My Room icon on the left side navigation to see a context menu. Choose 
“Configure” to go to the preferences to modify credentials and conference bridge details.  
 
Choose “Copy invitation” to copy an invitation link to the operating system clipboard. Paste 
this link to for instance meeting invitation e-mails to allow UC Office participants to join the 
conference in one click from for example, Outlook or Office applications. The link has two 
parts, one for UC Office users and another one for users with some other client. The invitation 
also contains a link to the desktop share session as well as dial-in number and PIN for users 
who do not have UC Office. The desktop share link allows anyone to join a desktop share 
session from a standard web browser. Also the UC Office group chat session is supported with 
the web collaboration session. 
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For more information, see section 4.3 for details on how to configure your My Room and 
section  8 Share Desktop for details on desktop sharing. Sharing works the same in both My 
Room and ad hoc sessions. 
 
My Room utilizes your permanent chat room, permanent collaboration room, and your 
conference bridge (audio or video). My Room is the only way to use the permanent rooms. Any 
other multiparty communication, such as multi-selecting contacts and right-clicking to a 
conference call or dragging and dropping to a 1-1 chat is done using ad hoc rooms. Ad hoc 
rooms are deleted once the session is over. 
 
All My Room sessions start as chats but call and/or share can be added to the session while in 
progress. File transfer and video conferencing are not supported in My Room or ad hoc 
sessions. 
 

12 Search 

 
UC Office supports a comapnydirectory search. This takes place in the same search field that is 
used for both a local and presence-enabled contact list search. 
 
UC Office automatically searches the local contacts and presence-enabled contact list in 
addition to the company directory at the same time. As soon as there are results from the 
company directory, these results are shown on a separate list in the main window. 
Additionally, there may be other search result groups from other search sources such as LDAP 
or Outlook. 
 
The company directory searches for the first name and last name. 
 
Typically when adding a contact using directory search results, there are phone numbers and 
first names in addition to last names available. In addition, the IM&P address and other fields 
are imported when found to allow presence and chat. 
 
LDAP search needs to be enabled by your service provider. Also you need to manually provide 
your LDAP credentials in the Preferences → Security tab. LDAP search results are provided in 
the Corporate Directory group in the search results. 
 
Outlook integration (search and calendar integration) on Windows requires one of the 
following versions installed on the desktop: 
 

 Outlook 2007 
 Outlook 2010 

 
Outlook search also works when several Outlook accounts are in use, but only one account is 
used at a time (default selected, which can be changed in Outlook). Additionally, other related 
considerations are as follows: 
 

 The client searches for Contacts and Calendar entries in the default Outlook account. 
The account is set to the default via File → Info (left pane) → Account Settings → 
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Account Settings → Data Files. Select an account and mark it as “Set as Default”. After 
making this change, sign out and sign back in to the client and it now searches that 
account for Contacts and Calendar entries. 

 
 For some users, the client shows Outlook’s proprietary Access/Deny security pop-up. 

This is triggered every thirty minutes when trying to read Outlook contacts and putting 
them into the client’s local cache. Some users are only offered the option to “Enable” 
the integration for ten minutes only. This Outlook security pop-up is triggered by 
Outlook Object Security model when UC Office tries to read a contact's email address 
property. This error happens when the customer’s computer does not have anti-virus 
software installed or if it is not up to date with the latest virus definitions. For some 
users, it is possible to disable Outlook security pop-ups in the Trust Center. If you are 
not using Outlook in an administrator role, it is possible to try to exit Outlook and 
launch Outlook from the app icon in administrator role via right click using “Run as 
admin” menu. This requires that you have administrator rights on the machine 
however.  

 
 Some users are never prompted anything regarding Access/Deny popup, but after a 

while in login, UC Office displays “Outlook not found” message.  
 

- This happens when trying to create Outlook instance at login. For some users, it 
takes around ten to fifteen seconds and the Outlook API fails to create such an 
instance and UC Office shows "Outlook not found" message. As described in that 
error dialog description, you should exit and restart the client. The Outlook API 
should work the second time you try to launch.  

 
 The client searches the Outlook Contacts only on the local machine (that is, the Outlook 

Address Book). There is no Exchange server lookup performed. In addition, all 
directories in Outlook are searched for contacts, even deleted folders. The Contacts 
directory can also have multiple levels of subfolders.  

 
Every minute, UC Office reads Outlook appointments. If there exists an appointment running 
at current time, the presence is shown as “Busy – In Meeting”. Overlapping appointments are 
also handled. Examples of UC Office operation with Outlook when time is 9:10 AM:  
 

 There is meeting "A" 9AM - 10AM. Presence is shown as “Busy – In Meeting”.  
 Presence is explicitly changed to Available at 9:15 AM. Presence is shown as “Available”.  
 In the next minute, UC Office again reads the appointments and sees that "A" meeting 

is running but presence already was explicitly marked as “Available”, and presence is 
not shown as “Busy – In Meeting” but “Available”.  

 There is an overlapping meeting "B" 9:30 AM - 10:30 AM. Presence is shown as “Busy – 
In Meeting” when the time is 9:30 AM.  

 
When deleting a meeting in Outlook that is currently ongoing, presence status remains as 
“Busy – In Meeting” until the next time Outlook appointments are checked (once every minute) 
and after that presence is shown as “Available”. This change may be instantaneous or a minute 
depending on how close to the timer is to being triggered.  
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Outlook Object Security model has been introduced in Outlook 2007. It has been tested with 
Outlook 2007 and Outlook 2010. For Outlook versions prior to 2007, the Allow/Deny pop-up 
should not be triggered. However those versions are not officially supported. For Outlook 
2013, the behavior should be similar to 2007 and 2010. However more tests are needed for 
this before official support for Outlook 2013 can be declared.  
 
The presence update is only triggered by appointments and meetings that are either accepted 
by the user or made by them. All day meetings do not trigger a presence change to "Busy - In 
Meeting". 
 

13 Full Company directory 

 
UC Office allows browsing an entire company directory. Click the Directory button on 
the left side of the navigation bar (if available) to view the company directory. This 
feature depends on the service provider configuration, so it may not be visible in all 
clients. 
 

14 Communications History 

 
The fourth icon from the top in the main window left side navigation displays your messaging 
history. Double-clicking a conversation on the list opens it in a new window. 
 
UC Office saves a call history for placed, received, and missed calls. The call history makes it 
easy for you to redial and call back when you have missed a call or you want to easily dial a 
contact with whom you have recently spoken. 
 
Double-click on a name on the list to call back directly (this calls back the same way you 
previously spoke, for example, if you were in a video call, double-clicking starts a new video 
call). 
 

15 Preferences 

 
Preferences provide access to available settings for UC Office. Follow these steps to access 
Preferences. 
 
1) Click the UC Office logo in the main window title bar. 
2) Select Preferences. 

15.1 Credentials 

My Room 
 
Specify the conference details to be used for your My Room. 
 



                 

 

 

 
Copyright © Cloud Direct 2013        UC Office for Desktop - User Guide (2)  23 

Web Collaboration 
 
Web collaboration credentials need to be manually entered and can be seen and edited here. 
 
Protocols 
 
If protocols are available to be viewed, they display here. 

15.2 General 

Language 
 
Select your language and then press OK or Apply and the change takes effect immediately.  
 
Note that the number of languages depends on your service provider. 
 
Log In 
 
Enable or disable automatic sign in when starting the application. 
 
Confirmations 
 
Usually there is a confirmation pop-up notification each time you remove a contact or call 
history record. By selecting one or all of the check boxes, you disable the confirmations when 
deleting information. Here you can also control if there always is a pop-up for publishing 
location information, typically this is shown at login. 
 
Depending on your service provider configuration, you can also have confirmations for UC 
Office API which is used by third-party applications such as Outlook Addin. You can allow such 
third-party applications to get information from UC Office and enable or disable confirmation 
pop-ups when third party applications request information from UC Office. You can also 
choose default behavior for always rejecting or accepting requests from third-party 
applications. 
 
Logging 
 
Logging is used for troubleshooting. 

15.3 Audio 

Playback Device (Speakers) 
 
Choose a headset, PC-integrated speakers, or external speakers for audio output. Your 
external playback device is selected by default (if you have one connected). 
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Recording Device (Microphone) 
 
Choose a headset microphone, PC-integrated microphone, or external microphone for voice 
during calls. Your external recording device is selected by default (if you have one connected).  
 
You can also choose automatic gain control and test your recording device. 
 
Ring Signal 
 
Select the ring signal that is played when you receive an incoming call. The same signal is used 
for both voice and video calls. You can also select your own ring signal. 
 
Sounds 
 
Select which events cause a notification sound. To disable the sound, uncheck the check box. 
Select a sound event and then click Play to hear the sound. 

15.4 Video 

Capture Device 
 
Select a camera that you want to use for video calls. Your external web cam is selected by 
default (if you have one connected). 
 
Video Size 
 
Select one of the available resolutions; note, however, that higher resolution requires more 
bandwidth and CPU. 

15.5 Proxy 

Select how to handle HTTP proxies, by default the system settings are used but you can also 
choose not to use a HTTP proxy or use UC Office proxy settings. 
 

16 Call Settings 

 
UC Office supports the following Feature Settings management allowing your Features to be 
managed using the native UC Office Call Settings window: 
 

 Call Director 
 Remote Office 
 Call Forwarding 
 Do not Disturb 
 Hide number (Calling Line Identification Presentation [CLIP]/Calling Line Identification 

Restriction [CLIR]) 
 Simultaneous Ring Personal 
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16.1 Call Director 

Call Director allows service providers to offer fixed-mobile convergence (FMC) services today 
without additional equipment. 
 
Call Director simplifies communications for on-the-go users and remote users by extending 
the features of a desk phone to any other fixed or mobile device, regardless of the network or 
handset manufacturer. Callers dial one number and can reach you on any phone the user 
chooses. A desk phone, mobile phone, and/or a soft phone can ring simultaneously. 
Enjoy voice call continuity with the ability to move live calls from one device to another 
without hanging up. 
 
Add locations (numbers) that can be used in the service via Add New Location button. Use the 
checkbox Alert all locations simultaneously to activate parallel ringing. 
 
Diversion inhibitor checkbox prevents a call ending up to a voice mail, which can be 
problematic in for example, conference call situations. 
 
Select Answer Confirmation confirmation to receive a separate audio prompt when answering 
a call from that number (location). It can be useful in cases where for example, mobile 
numbers are being used to prevent incoming calls going to mobile voice mail since the call will 
be ended without going to voice mail if the answer confirmation is not provided. 
 
Select Call Control checkbox to enable the server platform to provide mid-call services such as 
Call Transfer and Conferencing for that number (location). 

16.2 Remote Office 

This is a service that allows using any phone as the office phone from  a charging and 
numbering perspective. For instance a hotel room phone can be used as the office phone. 
Enable Remote Office clicking the Edit icon and specify a phone number to be used as the 
Remote Office number. 

16.3 Forward Calls 

Enter a number to forward your calls to. Different variants of call forwarding are supported, 
such as forward always, when busy, when you cannot answer or when unreachable. 
 

16.4 Do Not Disturb 

When you activate this service, all calls are blocked by the server and sent to voice mail 
typically. Enable this service by clicking the Enable checkbox. 
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16.5 Hide Number 

You can hide or display your number when calling or communicating with other parties or 
contacts. Hide your number by setting the Enable checkbox. To show your number, set to 
Disable. 

16.6 Simultaneous Ring Personal 

Add up to ten additional numbers or Session Initiation Protocol Uniform Resource Identifier 
(SIP-URI) addresses that you would like to ring in addition to your primary number when you 
receive a call. Also specify if you want answer confirmations. This service is an older variant of 
Call Director. 
 

17 Sign Out 

 
Signing out of UC Office sets your status to Offline for your contacts and displays the Sign In 
screen. Follow these steps to sign out: 
 

1. Click the UC Office logo in the main window title bar. 
2. Select Sign Out. 

 
To exit the application completely, follow these steps. 
 
Close the Sign In window: 
 

1. Select the UC Office logo in the main window title bar. 
2. Click Exit. 

 
NOTE: Closing the main window (not the Sign In window) does not exit the application but 
minimizes the application to the System Tray (Dock). This allows you to continue to receive 
calls and messages without having the contact list window displaying on the desktop. 
 

18 Multi-Device Support 

 
UC Office provides support for users with multiple devices such as UC Office for Smart Phone 
on Android or iPhone. 
 

 Chat invitations sent to the user are received in the highest priority online client. 
Before the session is accepted, the messages are sent to all devices and once 
answered, the chat messages go to the device that has sent a reply message. 

 
 Retrieving one’s own presence notifications can be done when another client updates 

user’s presence. UC Office does not update its own status based on the information it 
receives from the server, but the contact list is always the same for all devices. 
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 Accepting a sharing presence invitation in one client is also recognized by another 
client and both clients start receiving presence updates. 

 
 A new presence subscription made in one client is recognized in another. If the contact 

blocks the “invitation”, there are presence notifications from the server to all of the 
user’s clients indicating that the subscription was terminated and this information is 
shown to the user. If UC Office receives two presence authorization requests from two 
or more devices of the same user, it only shows one request to the user. 

 
 Removing a contact from the contact list in one device is recognized in another client 

and the contact list is updated (that is, the contact is removed) in the other client as 
well. 

 
If a user has many devices, each device can have a different status when shown to the user. 
However, watchers in the contact list always see the updates in priority order as follows: 
 

1. Busy 
2. Online 
3. Away 
4. Offline 

 
This means, for example, if one client publishes a “Busy” status and another client publishes 
something else, watchers see the user as “Busy”. 
 

19 Troubleshooting 

 
Why can’t I change my avatar? 
 
Double-clicking the avatar should open a file explorer view to select a file. If your XMPP 
connection is lost, changing the avatar does not succeed. A lost XMPP connection is indicated 
in the main window top notification area. 
 
My contacts are all offline and my client’s status bar says “XMPP unavailable”. What does this 
mean? 
 
It means that the XMPP connectivity has been lost for chat, as well as for presence; however, 
you can still make calls. You should contact your service provider if this persists. 
 
Why am I offline? 
 
If you have selected “Offline” status you will be shown as offline to others. Another possibility 
is that you may have lost your internet connection, in this case the client does not log out, but 
enters an offline mode where contact list is available but communication is not possible. 
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Why can’t I have more video resolutions available? 
 
You can choose your video resolution from Preferences and the Video tab. Your selection is 
used by default for future video calls. The available resolutions are automatically presented 
based on your camera. 
 
Why can’t I change my username and password? 
 
Username and password editing is not supported in the client. To edit your username or 
password, access the Business Portal or contact your service provider. 
 
In the preferences, the client supports changing only LDAP and desktop share credentials. 
Why does my all day calendar entry not trigger “Busy – In Meeting” presence status? 
 
All day meetings do not trigger a presence change to “Busy - In Meeting”. 
 
To trigger the presence update, the meeting has to be self-generated or accepted (tentative or 
fully accepted). The presence update is only triggered by appointments and meetings that are 
either accepted by the user or made by them. 
 
Why aren’t all my group chat messages saved? 
 
Only the newest chat room messages are stored on the server. 
 
Why aren’t all my chat messages available in my other devices? 
 
All 1-1 chat messages are saved, but only locally, so they will not necessarily be available in 
your other devices. Incoming messages are sent to all devices but the ones that you send are 
only stored in the device which you are using to send the message. 
 
 
 


